APPENDIX

B

Dreamweaver 4,
Menu by Menu

Dreamweaver 4: The Missing Manual is quite complete; in its pages, you'll find de-
scriptions of every major Dreamweaver function (and most minor ones). In the
interests of completeness, however, here’s a quick reference to every command in
every menu—and the answer to the occasional “what does that mean?” mystery.

Note: The chapter and page-number references in this appendix refer to the printed edition of Dream-
weaver 4: The Missing Manual.

The commands in the File menu control the open Dreamweaver document as a
whole. They also include basic file functions like saving and quitting.

+ New. Creates a blank, untitled Dreamweaver document (Web page).

+ New From Template. Creates a new Dreamweaver document based on the for-
matting and canned elements of a pre-existing template document (see Chapter
17). The Select Template dialog box appears and prompts you to choose the tem-
plate you want to apply. The “Update Page when Template Changes” checkbox
makes the document self-updating to reflect any changes you or your coworkers
later make to the underlying template.

+ Open. Opens the standard Open File dialog box so you can choose an existing
Dreamweaver document to open. You can set the Show pop-up menu to show
only specific types of documents—only HTML or style sheets, for example. The
Preview button displays a thumbnail image of the document, if one is available.
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+ Open in Frame. Opens an existing HTML page within one frame of a frameset.
To make this command available, you must first click inside a frame to select it—
not just in the Frameset document. The Select HTML file dialog box opens and
lets you navigate to the file you wish to insert into the Frame. You can also choose
to make the file’s URL relative to the document or the root folder, as described in
Chapter 4.

+ Close. Closes the open Dreamweaver document. If you have unsaved changes,
Dreamweaver gives you the opportunity to save them.

+ Save (Save Frameset/Save Frame). Saves any changes you've made to your docu-
ment. The Save command is dimmed if you haven’t made any changes to the
document since the last time you saved it.

Note: If you are working on a frames-based document, this command may say Save Frameset or Save
Frame, depending on what's selected.

+ Save As (Save Frameset As/Save Frame As). Saves a copy of the current docu-
ment under a new name, closing the original version and leaving the new version
onscreen. Here again, if you're working on a frames-based document, this com-
mand says either Save Frameset As or Save Frame As, depending on what’s se-
lected.

Save as Template. Saves the current document as a template file with the suffix
.dwt. The Save as Template dialog box appears, so that you can specify the
template’s file name and indicate which site it belongs to. Dreamweaver auto-
matically saves all template documents in a Templates folder in the selected site’s
folder.

Save all Frames. Saves changes to all the HTML files associated with a frameset.

Revert. Undoes any changes you've made to the document since the last time you
saved it.

Import. Allows you to import data from other sources into your Dreamweaver
document, such as XML data into a Template document, HTML generated by
Microsoft Word, or tabular data from a spreadsheet program like Microsoft Ex-
cel. (Use the submenu to specify which.)

Export. Extracts tabular data, Cascading Style Sheet styles, or tagged XML data
from your Dreamweaver document, for use in other applications.

Convert. Cascading Style Sheets work only in 4.0 browsers and higher. This handy
command, fortunately, can automatically convert unsupported page elements
into 3.0-compatible formats. You can opt to turn CSS layers into a table and to
replace CSS styles with HTML markup.

+ Preview in Browser. Opens the current document in your Web browser. (You
have to save your framesets before you can preview them.) By selecting Edit
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Browser List, you can add new browsers to, or delete browsers from, your browser
list, or specify a preferred browser.

+ Debug in Browser. This command checks a document’s JavaScript code for syn-
tax errors and then runs it in your Web browser, where you can test it for logical
errors. If you find errors, you can use the JavaScript Debugger window to isolate
the problem. The Edit Browser List command lets you add or delete browsers to
your list. (On the Macintosh, the debugger works only with Netscape Navigator.)

Check Links. Checks the current document for hyperlink problems like broken
links, external links, and orphaned pages. Results appear in the Line Checker
window, where you can immediately correct any linking problems.

In order for this feature to work, you must first define a local site and save the
page you wish to check somewhere inside that folder. (You can check links across
the entire site by choosing Site — Check Links Sitewide.)

Check Target Browsers. Checks the document’s HTML against previous Web
browser versions (Internet Explorer 2.0—5.0 and Navigator 2.0—4.0) for errors
like unsupported tags. For each selected browser, Dreamweaver produces a re-
port listing any possible problems, describes the error, and provides the line of
HTML code in which the offending tag appears.

Design Notes. Opens the Design Notes window (Chapter 16), where you can add
additional information about the document, set the status, and choose to have
the design note appear whenever the document is opened. (Note: to use design
notes on your site, you must make sure the Maintain Design Notes option is
selected in the Design notes section of the Site Definition window.)

[Recent documents.] Dreamweaver remembers the last several documents you
worked on and lists them here, for your re-opening convenience.

Quit. Exits Dreamweaver. If any of your open Dreamweaver documents have un-
saved changes, the program prompts you to save them before quitting.

Edit Menu

The Edit menu applies common document changes like copying and pasting.

+ Undo. Undoes the most recent change made to your document. You can choose
this command repeatedly to move progressively backwards through your changes.

* Redo. Restores whatever changes you just made by using the Undo command.
Selecting Redo multiple times moves you progressively forward through changes
you've undone.

+ Cut. Deletes the selected text or objects from the document and copies them to
the invisible Macintosh or Windows Clipboard so they can be pasted elsewhere.
(The Clipboard holds only one selection at a time.)
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+ Copy. Copies the selected text or object to the Clipboard so it can be pasted else-
where—without disturbing the original.

+ Paste. Places the most recent selection from the Clipboard into your document
at the insertion point.

+ Clear. Deletes the selected text or objects from the document without placing it
on the Clipboard.

+ Copy HTML. Copies a selection from Dreamweaver’s Design view (Chapter 1),
with its source code intact. You can then paste the selection into another pro-
gram, complete with all HTML tags.

Tip: If you're simply copying and pasting between Dreamweaver documents, use the regular Copy com-
mand; Dreamweaver automatically preserves all source code.

+ Paste HTML. Inserts source code copied from another application (or Dream-
weaver document) into your document’s Design view, preserving the selection’s
HTML tags. (Here again, if you’re simply pasting a selection you copied from the
Design view of another Dreamweaver document, use the regular Paste command
instead.)

Select All Selects everything in the document so you can make document-wide
changes in one fell swoop.

Select Parent Tag. Increases the current selection to include everything within
the parent tag, including its content. For example, if you had a table cell selected,
this command would increase the selection to the entire table row. Choosing the
command a second time would increase the selection to include the entire table.
In short, this command ensures that any changes you make apply to the entire
tag.

Select Child. Decreases the current selection to include everything within the
child tag, including its contents. If you selected a table row, choosing this com-
mand would decrease that selection to only include the table cell and its contents.

Find and Replace. Opens the Find and Replace window, which you can use to
search the document—or entire site—for a specific word, tag, or source code and
replace it with something different (Chapter 18). This command lets you make
such changes either en masse or one instance at a time..

Find Again. Uses the most recent search settings from the Find and Replace win-
dow to search the current document, highlighting the next instance of the re-
quested search item.

Indent Code. Adds one indent before the selected line of code. (Available only in
the Code View.)

Outdent Code. Removes one indent from the selected line of code. (Available
only in the Code View.)
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+ Balance Braces. When you’re editing a script in Code view, this command helps
you check for unbalanced braces (that is, an introductory < without a closing >)
by highlighting the matching tags enclosing the selected code.

+ Set Breakpoint. Marks a spot in your JavaScript code where you want the
program’s execution to stop. Breakpoints are represented with small red dots to
the left of the selected code. You can insert them only between script tags, or on a
line that contains an event handler. Use this feature in combination with the
File » Debug in Browser command.

Remove all Breakpoints. Removes all inserted breakpoints from the document.
Use this feature, too, with the File — Debug in Browser command.

Edit with External Editor. If you haven’t already specified an external HTML
code editor to use when editing large amounts of source code, such as BBEdit or
Notepad, this command opens the Preferences window so that you can find and
select one on your hard drive. Once you’ve specified an editor, this command
opens the current document in that editor.

Preferences. Opens the Preference window, which is full of options that custom-
ize the way Dreamweaver works. There are 16 categories of preferences, includ-
ing the color and format of different HTML tags, shorthand for CSS styles, and
the order in which panels appear on the screen. (Much more detail in Chapter
19.)

Keyboard Shortcuts. Opens the Keyboard Shortcuts window and shows you all
of the current keyboard shortcuts for Dreamweaver. You can create a new set of
shortcuts for specific sites or programs, or export the settings to HTML to share
with others. (You must duplicate the factory settings before you can add or delete
your own shortcuts.) Details in Chapter 19.

View Menu

The View menu controls the appearance of the document window. A checkmark in
the menu lets you know which view you're in.

+ Code. Displays the file’s source code.
+ Design. Displays the file’s visual design.

+ Code and Design. Splits the document window into two panes: source code on
top, visual design on the bottom. You can adjust how much of each pane is visible
by dragging the center divider up or downward.

+ Switch Views. Switches between the Code and Design views.

* Refresh Design View. Updates the Design view to reflect changes you've made
directly to the source code in either Code view or split (Code and Design) view.

+ Design View on Top. Switches the orientation of the split-pane view by placing
the Design view on top of the Code view.
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+ Head Content. Opens a new menu bar in the main document window that con-
tains shortcuts to accessing the file’s Head contents. You can use these menu items
to highlight your document’s Title tags, Meta tags, and scripts, and then edit
their content in the Properties Inspector.

Table View. Lets you switch between the standard table view and the layout table
view (Chapter 6). When in the layout table view, you can also choose to have
your tables display helpful tabs (by choosing the Show Layout Table Tabs
subcommand) which make it easy to adjust the table’s dimensions, make col-
umns autostretch, or add spacer images.

Visual Aids. Lets you summon onscreen symbols that represent typically invis-
ible page elements like image maps, anchors, and borders.

Code View Options. Lets you adjust the appearance of your HTML code in Code
view. You can turn on (or off) options that wrap lines of text to fit in the docu-
ment window, add line numbers, highlight invalid HTML, turn on syntax color-
ing, or indent lines of code.

Rulers. When you choose Show, Dreamweaver displays rulers along the top and
left sides of document window. Using the options you find here, you can choose
your ruler units: pixels, inches, or centimeters. You can also reset the orientation
of the two rules so that both start from zero in the upper-left corner of the screen.

Grid. Places a grid of vertical and horizontal lines over the document window to
use as a guide when drawing your layouts. Selecting Edit Grid opens the Grid
Setting dialog box, where you can adjust your grid’s colors, spacing, behaviors,
and line appearance.

Tracing Image. Adjusts the document’s background tracing image. You can load
a new tracing image, make a current one visible, or adjust its position.

Plugins. Lets you “play” browser plugins within the document window to test
embedded media. You can choose to play a document’s plugins one at a time, or
all at once, to simulate how the page will look to your viewers.

Hide Panels (Show Panels). Hides all open panels. If panels are already hidden,
the command says Show Panels instead and restores the panels to their original
positions.

Toolbar. Displays the Toolbar menu at the top of the document window. This
menu offers common commands like the document’s View settings, page title,
file management options, code navigation options, and browser preview.

Insert Menu

The Insert menu adds selected page elements to the document at the insertion point’s
position. The commands listed here correspond to the buttons on the Objects panel.
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+ Image. Inserts an image file, such as a JPEG or GIE into the document. The Se-
lect Image Source window appears and lets you navigate to the file you want on
your hard drive. You can choose to make the URL for the file relative to either the
document or the Site Root.

Interactive Images. Lets you create and insert images that interact with your visi-
tor. These include Rollovers, Navigation Bars, Flash buttons, and Flash Text. For
each type of interactive image, a different dialog box appears, allowing you to set
up the appearance and interactive specifications for the images.

If you created an interactive image from Macromedia Fireworks, you can also
choose to insert the HTML exported by Fireworks into your Dreamweaver docu-
ment.

Media. Inserts other types of media files, including Flash, Shockwave, Generator
Applets, Plug-ins, and Active X. In most cases, the standard Select File window
appears, which you can use to navigate to the desired file.

Table. Inserts a new table into the document. The Insert Table dialog box appears
and lets you format the table by specifying the number of rows and columns, the
table width, and measurements for cell padding, cell spacing and the table bor-
der.

Layer. Creates a new, blank layer at the insertion point. By default the new layer is
assigned the next highest Z-index number, placing it on top of all other layers on
the page.

Frames. Divides the current page into frames and creates a new frameset docu-
ment. You can choose from a variety of frame orientations, including designs
with single and triple framesets.

Form. Adds the Form tag to the document. This tag serves as a container in which
all of the form’s objects reside.

Form Objects. Inserts Form Objects—text fields, buttons, checkboxes, or lists—
into the document. (If you have not already inserted the Form tag, Dreamweaver
prompts you to do so.)

Server-Side Include. Adds a Server-Side Include, a reference to an external file
that will be merged by a Web server with the requested HTML document. This
command opens the Select File window so you can select the appropriate exter-
nal file.

Email Link. Creates a new email link at the insertion point. The Insert Email
Link dialog box appears; specify both the email address and the link’s text (such
as “Click to email me”).

Date. Inserts the current date into the document. The Insert Date dialog box lets
you format the appearance of the day of the week, the date, and the time. You can
also elect to have the date automatically updated each time the document is saved.
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Tabular Data. Inserts data from an external database program (or Excel) into an
HTML table. The Insert Tabular Data dialog box lets you select the data file,
specify how the data is delimitated (whether with tabs, commas, semicolons, etc.),
and the format of the resulting HTML table.

Horizontal Rule. Inserts a horizontal line into the document. You can specify its
width, height, and alignment in the Properties window.

Invisible Tags. Lets you insert invisible elements—anchors, comments, or
scripts—into the document.

Special Characters. Offers a menu of characters, such as the copyright, trade-
mark, and Yen symbols. HTML itself doesn’t recognize these symbols, which is
why you need a bit of special code (which this command inserts) to make the
appear correctly on your Web page.

Get More Objects. Opens the Macromedia Exchange for Dreamweaver Web site
in your browser. There you can search for, and download, new extensions and
objects to add new features to your copy of Dreamweaver. Use the Commands —
Manage Extensions command to add downloaded extensions to Dreamweaver.

Modify Menu

You can use the commands in the Modify menu to adjust the properties of common
document objects: links, tables, and layers, for example.

Page Properties. Opens the Page Properties window, where you can specify docu-
ment-wide attributes such as the page title, background and link colors, page
margins, and background image, or select a tracing image to use as a reference for
designing the page.

Selection Properties. When this item is selected (as indicated by a check mark in
the menu), the Properties Inspector palette is on the screen; you use it to edit the
current settings for selected page elements. The list of options displayed in the
Properties window change according to what type of page element is selected.

Quick Tag Editor. Lets you edit an HTML tag without leaving the Design view. If
nothing on the page is selected, the QuickTag editor prompts you to enter a new
HTML tag at the insertion point (by choosing from the alphabetical menu). But
if text or an object is already selected when the QuickTag Editor is opened, the
window displays the selection’s HTML tags for editing.

Make Link. Turns a highlighted page element (graphic or text) into a link. The
standard Select File dialog box appears; choose the document you want to open
when someone clicks the link.

Remove Link. This command is available only when a link is selected or the in-
sertion point is inside of a link. It deletes hyperlinks by removing the <a href>
tag from the selected text or image.
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+ Open Linked Page. Opens the linked page in a new document window. This com-
mand is available only when a link is selected or the insertion point is inside of a
link.

Link Target. Sets a link’s target and defines whether the linked page will appear in
the same browser window or a new one. You can choose from blank, parent, self,
or top targets, or manually define the target in the Set Target dialog box. This
command is only available when a link is selected or the insertion point is inside
of a link. (See Chapter 4 for details on links.)

Table. Opens a list of options for modifying a selected table. You can adjust the
number of rows and columns, add row or column spans, or completely clear
cells’ defined heights and widths (Chapter 6).

Frameset. Offers options for splitting the current page into frames (Chapter 7).
Or choose the Edit No Frames Content command to create alternative Web-page
material that can be read by older browsers that don’t support frames.

Navigation Bar. If you inserted an interactive navigation bar from the Insert menu,
you can use this command to edit its settings or add new navigation elements.

Arrange. Lets you change the Z-index (the front-to-back order) of overlapping
CSS layers. You can choose to send a layer to in front of other layers, send it to the
back, and so on. You can also tell Dreamweaver to prevent overlapping layers
altogether.

Align. When you’ve selected two or more layers at once (by Shift-clicking them,
for example), this command allows you to align them either by their left/right
sides, tops, or bottoms. You can also choose to make all of the selected layers the
same width and/or height.

Convert. Because some older Web browsers don’t support CSS layers, you can
choose to convert a layer-based layout into a single, large table. (Note that you
cannot convert overlapping layers to a table.) You can also reverse the process by
breaking up an HTML table into separate CSS layers. In this case, every table cell
becomes a unique layer.

Library. Lets you add selected document objects to the site’s Library file (Chap-
ter 17). You can also update the current document, or multiple documents, to
reflect any changes you’ve made to a Library object.

Templates. These commands affect template documents (Chapter 17). Using these
commands, you can apply a pre-existing template to the current page, separate
the page from its template, or update the page to reflect changes made to its
template. If the open document is a template file, you can use this menu to create
or delete editable regions and update all site files based on that template.

Timeline. Opens the Timelines panel, in which you can setup and refine anima-
tions within Dreamweaver (Chapter 12). The submenu provides options for add-
ing or deleting timelines, frames, objects, or behaviors.
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Text Menu

As you could guess, the commands in the Text menu format and modify the
document’s text.

+ Indent. Adds one level of indentation to everything within the current block-
level element (paragraph, headline, bulleted list).

+ Outdent. Removes one level of indentation from everything within the current
block-level element.

+ Paragraph Format. Applies a paragraph format, such as Heading 1, Heading 2,
or preformatted text, to all of the text in the current block-level element. You can
also choose None from the submenu to remove the paragraph formatting.

Align. Aligns text in the selected paragraph to the left margin, center, or right
margin of the document. If the paragraph is inside a table cell or layer, Dream-
weaver aligns it with the left, center, or right of that cell or layer.

List. Turns the selected paragraph into an ordered, unordered, or definition Iisz.
You can edit the list’s format by selecting the Properties option from the sub-
menu.

Font. Lets you choose from a list of common font combinations for application
to the selected text. When displaying text, your visitor’s browser will move down
the list of assigned paragraph fonts until it finds one installed on its system (Chap-
ter 3). You can create your own combination of paragraph fonts by choosing Edit
Font List from the submenu.

Style. Applies pre-defined text styles, such as Bold, Italic, or Strikethrough, to the
selected text.

HTML Styles. Lets you create canned groups of HTML font tags that you can use
repeatedly in your document to save time when formatting text (Chapter 3). The
New Style submenu command opens the Define HTML Style dialog box, where
you create a unique combination of style tags. New styles are saved in the HTML
Styles submenu.

CSS Styles. Lets you create new CSS (Cascading Style Sheet) styles and apply
them to selected text (Chapter 8). You can also choose to attach an existing style
sheet to the current document, or export the document’s own style sheet for use
in other sites.

+ Size. Applies a new size to the selected text. Sizes range from 1 (the smallest) to 7
(the largest); as described in Chapter 3, HTML sizes are relative, and change de-
pending on your visitors’ browser preferences.

+ Size Change. Increases or decreases the selected text’s size relative to the
document’s basefont size (which is set to 3 by default).
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+ Color. Opens the standard Mac or Windows color picker dialog box, so that you
can choose a color to apply to the selected text. Macintosh: You can choose from
a variety of color palettes, including CMYK, RGB, HTML (Web safe), HSV, and
HLS. Windows: In general, the Property Inspector’s Color box is a better way to
assign Web colors to text.

+ Check Spelling. Checks the current document for possible spelling errors (page
52).

Commands Menu

You can use Commands menu to apply advanced features to your Dreamweaver
document. Some menu items, such as the Record commands, eliminate repetitive
tasks; others, such as the Clean Up HTML command, fix common problems in a
single sweep.

+ Start/Stop Recording. Records a series of actions that can then be reapplied to
other parts of the document (Chapter 18). When you select the Start Recording
command, Dreamweaver records each of your actions until you choose Stop Re-
cording. Note that Dreamweaver only retains one recorded command at a time.

Play Recorded Command. Reapplies the most recently recorded command.

Edit Command List. Opens a list of all saved commands. You can rename the
commands or delete them permanently.

Get More Commands. Opens the Macromedia Exchange for Dreamweaver Web
site in a new browser window, so that you can search for, and download, new
extensions or commands. Extensions are downloaded to your Extension Man-
ager. (See Chapter 19.)

Manage Extensions. Opens the Extension Manager, a program that lets you man-
age extensions you download from the Macromedia Exchange Web site (Chapter
19). The Extension Manager helps you install, delete, and selectively disable ex-
tensions.

Apply Source Formatting. Changes you make to Dreamweaver’s HTML source
formatting (which is defined in the Preferences window and the SourceFormat.txt
file) apply only to newly created documents. This command, on the other hand,
offers a way to apply these formatting preferences to existing HTML documents.

Clean Up HTML. Opens a list of options for correcting common HTML prob-
lems, such as empty tags or redundant nested tags. Once you’ve selected what
youd like to fix, Dreamweaver applies those changes to the current document
and, if requested, provides a log of the number and type of changes made. (See
Chapter 15.)

Clean Up Word HTML. If you import HTML that was generated by Microsoft
Word, you often end up with unnecessary or cluttered HTML tags that can affect
your site’s performance. This command opens a list of options that can correct
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Commands Menu formatting problems common in Microsoft Word’s HTML. Dreamweaver ap-
plies your selected changes to the document and, if requested, displays a log of
the number and type of changes made.

+ Add/Remove Netscape Resize Fix. This command lets you insert JavaScript code
into your document that counteracts a bug in some versions of Netscape Naviga-
tor (it causes pages that use layers to display incorrectly when the browser win-
dow is resized). The inserted code makes the page reload every time a browser
window is resized.

+ Optimize Image in Fireworks. Opens the selected image in Macromedia Fire-
works’ Optimization window, where you can experiment with different com-
pression settings to find the best balance between file size and image quality. If
you used Fireworks to create the image in the first place, you can choose to use
the original Fireworks PNG file or the selected image (GIF or JPEG file) as the
source image. Dreamweaver then replaces the selected image with the newly op-
timized image.

+ Create Web Photo Album. Lets you turn a folder of images into a Web-based
photo album. The Create Web Photo Album window appears; specify a title for
your album, the source folder, and so on (see Chapter 18).

Note: This command requires Macromedia's Fireworks image-editing program, which creates thumbnail
and full-sized versions of each image. Dreamweaver then creates a Web site with one page displaying all
of the thumbnail images. The thumbnails are linked to individual HTML pages containing the full-sized
images.

+ Set Color Scheme. Opens a list of preset Web-safe color combinations for a
document’s background, text, and links. Using the Preview window, you can ex-
periment with different color sets until you find one you like, and then apply it to
your document automatically.

+ Format Table. Opens a list of preset formatting options for your HTML table,
including color schemes, text alignment and style, and border measurements.
(Unavailable when a table is in Layout mode.

+ Sort Table. Sorts the information in a selected table. You can choose to sort al-
phabetically or numerically, in ascending or descending order. This command
cannot be applied to tables that include rowspans or colspans.

Site Menu

As its name suggests, the commands in this menu apply to your entire Web site,
rather than to a one document at a time. These commands can help keep your Web
site organized and promote collaboration between large workgroups.
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Note: The Windows version of Dreamweaver offers menus in two different locations. In addition to the
standard menu bar at the top of each document window, described so far in this appendix, you'll find a
second menu bar at the top of the Site window. Its commands are described at the end of this Appendix.

For now, simply note that some of the commands listed below are noted as Macintosh-only or Windows-
only. It's because the commands’ locations differ in the two versions of the program.

+ Site Files (Windows only). The Site window offers two different views: Files View
and Sitemap View (see pages 376-382). This command pertains to Site Files view,
and its submenu lets you add new files or folders to the file list, refresh local and
remote lists, select the most current version of a file, or adjust the File View set-
tings.

Site Map (Windows only). These commands, on the other hand, apply exclu-
sively to Sitemap View (page 380). You can create new links, manage existing
links, define a new home page, display hidden and dependent files, or adjust the
sitemap’s layout.

New Site. Defines a new Web site. The Site Definition dialog box appears and lets
you specify the settings for your local site (Chapter 1), including a name for the
new site, the folder in which all of your site documents will reside, and the final
HTTP address. You can also choose to let Dreamweaver cache your site files to
help keep track of changes, links, and assets. To the left of the window are addi-
tional options for your new site, including information about the Remote server,
design notes, your site map’s layout, and the preferred format for viewing file
lists.

Open Site. Lets you choose from a list of currently defined sites to open. If you
don’t see the site you want in this list, you can choose the Define Sites option to
create a different site. When a new site is opened, the Site Information window
changes to reflect the settings for the new site.

Define Sites. Lets you define or edit an existing Web site on your local machine—
a useful trick for importing Web sites that weren’t originally created in Dream-
weaver. You can also duplicate or remove defined sites. When you click Done,
Dreamweaver scans the defined site and displays its file list in the Site window.

Connect (Macintosh only). Connects you to the remote site on the Web. While
you're connected, the menu option changes to say Disconnect.

Refresh (Macintosh only). Manually updates the local and, if applicable, the re-
mote folder lists to reflect changes to the site. This step is primarily necessary if
you've disabled the option to refresh the file list from the Site Definition window
automatically.

+ Site Files View (Macintosh only). The Site window offers two different views:
Files View and Sitemap View (see pages 376-382). This command pertains to Site
Files view, and its submenu lets you add new files or folders to the file list, refresh
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local and remote lists, select the most current version of a file, or adjust the File
View settings.

+ Sitemap View (Macintosh only). These commands, on the other hand, apply ex-
clusively to Sitemap View (page 380). You can create new links, manage existing
links, define a new home page, display hidden and dependent files, or adjust the
sitemap’s layout.

The next five menu commands let you transfer files between your computer (the
local site) and a Web server (the remote site). These commands, in other words,
don’t work unless you've first defined a remote site in the Site Definition window. In
addition, these operations work only files that you’ve selected in the Site window.

+ Get. Copies files (those you've selected in the Site window) from the remote server
to the local site folder for editing. Note that if the File Check In and Check Out
feature is active, the downloaded files will not be editable.

Check Out. Copies files (those you've selected in the Site window) from the re-
mote server to your local site and marks them on the remote server as checked
out. No one else will be able to make changes to the document until you upload
it back onto the remote server.

Put. Uploads files (those you've selected in the Site window) from the local site to
the Remote site. The uploaded file will replace the previous version of the docu-
ment.

Check In. Uploads checked-out files from the local site to the Remote site and
makes them available to be edited by others. Once a file is checked in, the version
on your local site becomes Read-only (openable, but not editable).

Undo Check Out. Removes the checked-out status of selected files. The file is not
uploaded back to the remote server, so any changes you made to the file will not
be transmitted to the Web server. Your local copy of the file becomes Read-only.

Reports. Opens the Reports window and lists options for generating new reports
(Chapter 15). Reports can monitor workflow (such as design notes and checkout
status) and common HTML problems (such as Missing Alt text, empty tags, un-
titled documents, and redundant nested tags). You can generate a report on just
the open document, multiple documents, or the entire site.

Check Links Sitewide. Analyzes the current site for broken links, external links,
and orphaned pages. Dreamweaver then generates a report listing all of the found
problems. You can fix problematic links directly in the Report window—or click
on the file name to open the errant file in a new document window with the link
highlighted and ready to repair.

+ Open (Macintosh only). Opens whatever files you've selected in the Site window.
Each file appears in a separate document window.

DREAMWEAVER 4: THE MISSING MANUAL



+ Rename (Macintosh only). Highlights the selected document’s file name. As you
type in a new name, Dreamweaver replaces the old one.

+ Unlock. If any of the files selected in the Site window are locked, Dreamweaver
unlocks them, making them editable in Dreamweaver.

+ Locate in Local Site. When working on a document, selecting this option opens
the Site window and highlights that document’s file in the site’s Local folder.

+ Locate in Remote Site. When working on a document, selecting this option opens
the Site window and highlights that document’s file in the site’s Remote folder.

Note: See Chapter 16 for the full scoop on remote sites, local sites, and checking files in and out.

+ Change Link Sitewide (Macintosh only). In one step, replaces a broken link that
appears multiple times throughout your site. In the Change Link dialog box, you
first specify the incorrect link; below it, enter the link with which you’d like to
replace it. Dreamweaver searches your site, replacing every instance of the old
link.

+ Synchronize (Macintosh only). Transfers the latest versions of your site files be-
tween the local and remote servers to make sure each contains an identical and
up-to-date file list.

* Recreate Site Cache (Macintosh only). Forces Dreamweaver to rescan the site’s
files and update its cache file to reflect any changes to the files or links in the site.

+ FTP Log (Macintosh only). Opens the FTP log, which contains a record of all
FTP file transfer activity. You can use this log to troubleshoot FTP transfer er-
rors.

Window Menu

This menu controls which panels and windows are visible or hidden at the moment.
(A check mark in the menu denotes open panels.)

+ Objects. Opens the Objects panel, from which you can insert various types of
objects (such as images, layers, or forms) into your document. The Object panel
also contains options for switching between Layout and Standard table views.

+ Properties. Opens the Property Inspector, where you can edit the relevant prop-
erties for a selected object. The options in the Property Inspector depend on
which page element is selected.

+ Launcher. Displays the Launcher Bar, from which you can easily open and close
commonly used windows and panels (the History panel or Code Inspector, for
example).
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+ Site Files. Opens the Site window. From this window, you can open any file and
transfer files between your computer and the remote server.

+ Site Map. Opens the Site Map option in the Site window. If you have not already
defined a homepage for your site, Dreamweaver prompts you to do so. The Site
Map offers a graphic representation of your site’s layout, to help you organize
pages and maintain links.

Assets. Opens the Assets panel, which conveniently groups and lists all of the
assets (such as colors, links, scripts, or graphics) you've used in your site.

Behaviors. Opens the Behaviors panel, which lets you associate behaviors (such
as swapping images in a Rollover or checking for needed plugins) to selected
page elements. (See Chapter 11.)

Code Inspector. Opens the Code Inspector window, which displays the HTML
code for the current document.

CSS Styles. Opens the CSS (Cascading Style Sheet) Styles panel, from which you
can define custom CSS styles or apply existing ones to selected text.

Frames. Opens the Frames panel (Chapter 7), a visual representation of the frames
within a document. You can select a particular frame in a frameset by clicking on
its name in the Frames panel, and then edit its properties in the Property Inspec-
tor.

History. Opens the History Panel, a list of the most recent changes made to the
current document. You can use the slider along the left side of the History panel
to quickly move back and forth through your steps, as though it’s a multiple
Undo command (page 54).

HTML Styles. Opens the HTML Styles panel. You can save HTML text and para-
graph formatting here and reapply them to other selections in your document.
HTML Styles offer an alternative to using CSS Styles, which don’t’ work in older
Web browsers.

Layers. Opens the Layers panel, which lists (by name and position) all of the
layers found in the current document. You can use this panel to reorganize layers,
select multiple layers simultaneously, make specific layers invisible, or prevent
layers from overlapping.

Library. Opens a list of the site’s Library items, a subsection of the Assets panel.
Here you can select Library items, make changes, and have those changes auto-
matically updated wherever an instance of that Library item appears in the site.

Reference. Opens the Reference panel, a searchable guide to HTML tags, Cascad-
ing Style Sheets, and JavaScript commands. The guides are culled from the popu-
lar O’Reilly reference books and include an explanation of what specific tags do,
when they can be used, what additional components are required, as well as tips
for getting the most out of them.
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+ Templates. Opens a list of the site’s Templates, a subsection of the Assets panel.
From the panel, you can open a Template file, make changes, and apply those
changes to any files based on that template document.

+ Timelines. Opens the Timelines panel, which you can use to setup and refine
layer or image animations within Dreamweaver.

+ Arrange Panels. Returns all open panels or windows to their default positions on
the desktop.

+ Hide Panels. Closes all currently open panels. Choosing Show Panels reopens
only those panels that were displayed before you selected Hide Panels.

+ Minimize All, Restore All (Windows only). Minimizes or restores all open Dream-
weaver windows, including documents, panels, and the Site window.

Help Menu

The Help menu offers useful links and references for more information about us-
ing, troubleshooting, and extending Dreamweaver.

+ About Balloon Help (Macintosh only). Opens a window containing a quick de-
scription of how Balloon Help works.

+ Show Balloons (Macintosh only). Turns on the Mac’s Balloon Help feature. As
you position the mouse over windows and some menu items, a small text-filled
balloon appears to describe whatever you’re pointing to, and sometimes to pro-
vide tips on how to use it. (This is a Macintosh feature, not a Dreamweaver fea-
ture, which explains why balloons don’t appear for most Dreamweaver items.)

+ Welcome. Opens a table of contents for Dreamweaver 4’s interactive lessons, in-
cluding an overview of new features, animated tours of the program, and a tuto-
rial for building a simple Web site. (This window appears automatically the first
time you launch the program.)

+ Using Dreamweaver. Opens an HTML-based reference guide to using Dream-
weaver. Topics are organized by tasks, such as “Setting Up a Document.”

+ Reference. Opens the Reference panel, a searchable guide to HTML tags, Cascad-
ing Style Sheets, or JavaScript, as described above.

+ What’s New. Opens a new window that offers a description of the new features in
Dreamweaver 4. Some topics include animated demonstrations. You can move
forwards or backwards through the presentation by clicking the arrows in the
bottom right corner of the window.

* Guided Tour. Opens a new window containing guided tours for using Dream-
weaver 4 to perform basic functions such as site planning, adding content, and
publishing your site.
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+ Lessons. Summons interactive step-by-step instructions for performing tasks such
as creating image maps, inserting tabular data, or adding Flash objects. You can
experiment either on your own document or on a canned practice page.

Dreamweaver Exchange. Opens the Macromedia Exchange for Dreamweaver Web
site (www.macromedia.com/exchange/dreamweaver). Here you can search for, and
download, new extensions (Chapter 19).

Manage Extensions. Opens the Extension Manager, a program that lets you man-
age extensions you download from the Macromedia Exchange Web site (again,
see Chapter 19).

Dreamweaver Support Center. Opens Macromedia’s online Dreamweaver Sup-
port Center Web page in your browser. This Web site offers technical support for
known bugs or common questions, downloadable updates to the program, and a
link to online forums.

Macromedia Online Forums. Opens an index of available online forums from
Macromedia’s Web site (in your Web browser). You can use the forums to inter-
act with other Macromedia customers, post questions, share techniques, or an-
swer questions posted by others. Requires Internet access and a newsgroup reader.

Extending Dreamweaver. Opens an HTML-based index of advanced techniques
for customizing and extending Dreamweaver 4: adding new panels, adding menu
commands, writing your own extensions, and so on.

Creating and Submitting Extensions. Opens an HTML-based document that
explains the procedure for creating and submitting your own extensions to the
Macromedia Exchange Web site.

Register Dreamweaver. If you didn’t register your copy of Dreamweaver 4 (pro-
vide your personal information to Macromedia) when you first installed the soft-
ware, you can use this option to register it at any time. You'll need the serial
number that came with the software.

About Dreamweaver (Windows only). Opens an About Dreamweaver window, show-
ing your software’s version number. (On the Macintosh, this command is in the @
menu.)

Site Window Menu (Windows)

In the Windows version of Dreamweaver, the Site window (page 376) has a menu
bar of its own. Some of the commands you’ll find here duplicate the commands in
the document window’s menu bar, but some are unique to the Site Window.

File Menu
The File menu commands control the Dreamweaver document as a whole, and in-
clude basic file functions such as saving and quitting.
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+ New Window, New From Template. These commands duplicate what’s in the Site Window
main File menu, described at the beginning of this document. Menu (Windows)
+ New File. Adds a blank, untitled Dreamweaver file to the local site folder. The

file’s name is highlighted in the Site window, making it easy for you to type a new
name for the new page.

The location of this new file depends on what’s selected in the Site Window’s
local folder list. If a folder is selected, Dreamweaver puts the new file in that
folder. If a file (HTML document, for instance) is selected, then the new file is
added in the same folder as the selected file.

New Folder. Adds a new, empty folder to the local site. The folder’s name—ini-
tially “untitled”—is highlighted so you can type a new name. The new folder’s
location depends on what you've selected in the Site window, as described in the
previous paragraph.

Open, Close. These commands duplicate what’s in the main File menu, described
at the beginning of this document.

Open Selection. Opens whatever files are selected in the Site window, each in a
separate document window.

Save Site Map. Saves a copy of the current site’s Site Map as a PNG or BMP graphic
file, suitable for emailing to a collaborator or client. (Available only if the Site
window is in Site Map view.)

Rename. Highlights the selected document’s file name. As you type in a new name,
Dreamweaver replaces the old one.

Delete. Deletes all files selected in the local folder list of the Site Window (after
first asking for confirmation).

Turn off Read Only. If Dreamweaver has designated any of the selected files in
the Site window as Read Only—in other words, they can’t be edited—Dream-
weaver unlocks them, making them editable.

Preview in Browser, Check Links, Check Target Browsers, Design Notes. Dupli-
cates the same commands in the main File menu, described at the beginning of
this document.

Edit Menu
The Edit menu lets you select and work with files in the Site Window.

+ Cut. In Site Map view, you can use Cut to remove a link from a page you've
selected. When you do so, Dreamweaver removes the link to that file, not the file
itself is not removed. (In Site Files view, Cut has no effect except to temporarily
remove the Dreamweaver icon from a selected file.)
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+ Copy. Duplicates the selected file in the Local folder—or, in Site Map view, a
selected link.

+ Paste. Pastes a duplicate of a file that you copied from the Site Window using the
Copy command. In Site Map view, pastes a cut or copied link onto the selected

page.
+ Select All. Selects all files in the selected pane of the site window. If the focus is on

the list of files in the Local Folder, for example, Dreamweaver highlights all files
in that list.

Select Checked Out Files. Selects all files that are currently checked out in the
Site Window.

Select Newer Local. Selects all files in the Local folder list of the Site window that
are newer than those on the Remote site. (This works only if you have defined a
Remote site and you're online. It can take fair amount of time to complete, if the
site is large, or your Internet connection is slow.)

Select Newer Remote. Selects all files in the Remote file list of the Site window
that are newer than those on the local site on your computer (contrast with the
previous item).

Invert Selection. Selects all unselected files and deselects all selected files in the
Site window.

Locate in Local Site. When files are selected in the Remote site list, Dreamweaver
highlights the corresponding files in the Local file list. (Once again, this works
only if you have defined a Remote site and you’re online.)

Locate in Remote Site. When files are selected in the Local file list, Dreamweaver
highlights the corresponding files in the Remote site list.

Find and Replace. Opens the Find and Replace window, where you can search
the document—or entire site—for a specific word, tag, or scrap of source code,
and, if you like, replace it with something different. This command lets you make
similar changes all at once, or lets you step through every instance to make changes
selectively.

* Preferences, Keyboard Shortcuts. These commands duplicate what’s in the main
Edit menu, described earlier in this document.

View Menu
The View menu controls the appearance of the list of files in the Site Window and
the Site Map.

* Refresh. Updates the local and, if applicable, the remote directory lists to reflect
changes to the site. This step is primarily necessary if you’ve disabled the option
to automatically refresh the file list from the Site Definition window.
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* Refresh Local. Updates the local folder list to reflect changes to the site. Again,
this step is primarily useful if you've disabled the option to refresh the file list
from the Site Definition window automatically.

* Refresh Remote. Updates the remote directory list of files to reflect changes on
the Remote site. If Dreamweaver isn’t already connected to the remote server, it
logs on to the remote site and retrieves a new list of files.

The next six options control the display of the Site Map:

+ Show/Hide Link. Hides a selected link on the Site Map—a useful trick for hiding
unimportant links to make Site Map more manageable. If you've made a hidden
link visible using the “Show Files Marked as Hidden” command described below,
the Show Link command makes it permanently visible.

* View as Root. Makes the selected page in the Site Map appear as the root, or
home, page at the top of the Site Map.

+ Show Files Marked as Hidden. Temporarily makes all hidden files visible in the
Site Map. Names of hidden files appear in italics when this option is selected. To
make hidden files disappear, reselect this command.

+ Show Dependent Files. Makes dependent files visible in the Site Map. (Depen-
dent files are non-HTML files used by the site’s Web pages—graphics, Flash mov-
ies, and CSS files, for example.)

+ Show Page Titles. The Site Map view usually lists files by their names—for ex-
ample, index.html. This command makes it instead display the titles of your Web
pages (“All About Almonds”).

+ Show Layout. Opens the Site Map layout preferences of the Define Site window.
Lets you assign a page to act as the home page for the site and control the num-
bers or rows and columns used to display the map.

+ File View Columns. Opens the File View Columns preferences of the Define Site
window. Lets you adjust the columns that appear in File View.

Site Menu

Just as with the Site menu in your document-window menu bar, this menu applies
changes to your entire Web site. Many of the commands are duplicated; they’re here
in the Site window purely for your convenience.

+ New Site, Open Site, Define Site. These commands are duplicates of the ones in
the main Site menu (at the top of your document window).

+ Connect. Connects you to the remote site on the Web. While you’re connected,
the menu option changes to say Disconnect.

The next set of menu commands let you transfer files between your computer (the
local site) and a Web server (the remote site). These commands, in other words,
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Site Window don’t work unless you've first defined a remote site in the Site Definition window. In
Menu (Windows) addition, these operations work only files that you’ve selected in the Site window.
+ Get, Check Out, Put, Check In, Undo Check Out, Reports, Check Links Sitewide.

These commands, too, duplicate what’s in the Site menu as described earlier in
this Appendix.

+ Change Link Sitewide. In one step, replaces a broken link that appears multiple
times throughout your site. In the Change Link dialog box, you first specify the
incorrect link; below it, enter the link with which you’d like to replace it. Dream-
weaver searches your site, replacing every instance of the old link.

+ Synchronize. Transfers the latest versions of your site files between the local and
remote servers to make sure each contains an identical and up-to-date file list.

* Recreate Site Cache. Forces Dreamweaver to rescan the site’s files and update its
cache file to reflect any changes to the files or links in the site.

The next seven options control actions in the Site Map.

+ Link to New File. Opens a dialog box that lets you create a new Dreamweaver
document and link it to currently selected page in the Site Map. You give the file
a name and title; Dreamweaver creates the new file in the same folder as the
selected page and adds a link to the page, using text you specify.

+ Link to Existing File. Creates a link from currently selected page in the Site Map
to an existing document that you choose using the Select HTML file dialog box.

+ Change Link. Makes a link (which you’ve selected in the Site Map) open a differ-
ent “target” document.

+ Remove Link. Removes the selected link in the Site Map from the page it’s on.
(Only the “linkness” is removed; the original text or graphics remain.)

+ Open Source of Link. Opens the document that a selected link has been pro-
grammed to open

+ New Home Page. Lets you create a new Dreamweaver document and designate it
as the home page in the Site Map. That new document appears in the Site Files
list and at the top of the Site Map.

+ Set as Home Page. Sets selected page in Site Map as the Home Page, which now
appears at the top of the Site Map.

Window Menu, Help Menu
The commands in these menus are duplicates of what’s in the main Window and
Help menus described earlier.
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